In this lesson you will learn how to:
 Import from the clipboard using Smart Import.

Tutorials
Lesson 9 - Make a Schedule
from a Spreadsheet

 Copy information from a spreadsheet program into Milestones Professional.
 Map the spreadsheet data to specified areas in Milestones
Professional.

Smart import from clipboard
Importing into Milestones Professional template from
a spreadsheet is made easier with Smart Import From
Clipboard.
1.

Set up your spreadsheet to have its column headings match Milestone Professional template’s column headings.

2.

Choose the Date tabs. Choose the calendar icons next
to Displayed Start Date and Displayed End Date. Set
the dates to the date range of the spreadsheet tasks.

3.

Choose Select All in the spreadsheet.

4.

Choose Copy.

5.

Then go back to Milestones Professional and choose: File | Import Options | Custom |Smart Import from Clipboard.
Milestones Professional Template will then be populated with the spreadsheet information.

Milestones’ Template

Spreadsheet information

Milestones schedule generated from “Smart Import From Clipboard.”

 To have percent complete be accurate, hourly minute detail must be turned on in Milestones. Choose the Dates tab. In the Start
and End Dates section, choose More Settings. Click Hourly /Minute.

 both Allow Hourly and Minute detail.

 To have the task bars fill with color based on the percent complete, fill to status must be turned on. Choose the Dates tab. In the
Date Related Settings section  both Symbols & Bars: Fill to Status Date

 The 32nd symbol in the toolbox becomes the status symbol. Double click this symbol in the toolbox to change its properties.
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Open the schedule for this lesson
Import Lesson Example
Spreadsheet

1. On the toolbar choose the File tab.
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2. In the Files and Templates: Open and Save Options section, click the 
(down arrow) next to Open.
3. Choose Lesson Chart.

4. Select Lesson 9 Starter Schedule.mlf.
5. Save the lesson schedule to an folder on your hard drive (such as your
Documents folder.) On the File tab, in the Files and Templates: Open
and Save Options section, click (the down arrow) next to Save As ...
Then, choose Chart. Now you have a copy of the lesson schedule.
Lesson 9 starter schedule

Copy information from a spreadsheet program into Milestones Professional
Open the Spreadsheet for this Lesson
1. Start up your computer’s spreadsheet program. (If you do not have a
spreadsheet program, you can create a table in another application such as
Word and use the information for this lesson).
2. Open the spreadsheet for this lesson. Note the file for this lesson is a csv
called Spreadsheet.csv. It is located in Program Files\KIDASA\Milestones
Professional 2015\Samples\lessons folder.
Spreadsheet information

3. Here is a snapshot of the information in the spreadsheet:

When creating date fields in the spreadsheet
the format must be in the default date order,
such as m/d/y that your computer uses.

Copy the spreadsheet information to the clipboard

1. In your spreadsheet program, Select All.
2. Click Copy in your spreadsheet program. This will copy the information to the Windows Clipboard.

Import the data from the clipboard into your Milestones Professional schedule
1.
2.
3.
4.
5.

Move over to your Milestones Professional schedule (usually by clicking
the Milestones Professional icon on the Windows task bar).
Choose the File tab.
In the Import Options section choose Custom.
From the menu choose Custom Import From Clipboard. The Import: Custom Format dialog box displays.
In the Import: Custom Format dialog box, you will map the spreadsheet
fields to Milestones fields and columns.
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Import the data from the clipboard into your Milestones Professional schedule (continued)
The numbers in the graphic below correspond to the next steps in this tutorial:

If filters need to be exchanged between colleagues
use the Export Filter /Import Filter options.

1.

Click the Clear Settings button. This will erase any previous filter settings (Map lines between fields).

2.

Under Fields from line 1 of input file, click once on Field 1: TASKS.
“TASKS” is in the first cell in the first column of the spreadsheet. Field 1 includes all of the first column data, as represented by “TASKS”.

3.

Under Field Usage in Schedule, click once on Column_10_Left.
This maps all information from the “TASKS” column in the spreadsheet to column 10 of the Milestones schedule. Column 10 is the column named “Project” in the Milestones file opened for this lesson. See page 9-4 of this tutorial for
information regarding mapping to columns.

4.

Under Fields from line 1 of input file, click once on Field 2: Start.
“Start” is in the first cell in the second column of the spreadsheet. Field 2 includes all of the second column data, as
represented by “Start”.

5.

Under Field Usage in Schedule, scroll and click once on Task_1_Start_Date.
This maps the dates in the “Start” column of the spreadsheet to import start date symbols in the schedule area

6.

Under Fields from line 1 of input file, click once on
Field 3: End.
“End” is in the first cell in the third column of the
spreadsheet. Field 3 includes all of the third column
data, as represented by “End”.

7.

Under Field Usage in Schedule, scroll and click once
on Task_1_End_Date.
This maps the dates in the “End” column of the
spreadsheet to import end date symbols with a connecting horizontal bar to the start date in the schedule area.

8.

Under Current Filter Name, type My Filter.

9.

Click the Save Settings button.

Import Lesson Example
Spreadsheet
Project

2018
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Mar

Computer Checkout

3/9

Upgrade

3/9

Apr

May

Jul

Aug

Nov

Dec

9/26

Guide

Test event 1

Oct

7/16

Requirements

Systems Development

Sep

11/20

7/16

3/9

7/2

Procedures Guide

10. Click the Continue Import Using Current Filter
button. The schedule now contains the imported
tasks and dates from the spreadsheet.

Jun

7/10

3/17

8/11

5/11

Schedule with imported data from a spreadsheet
11. The first row of the spreadsheet is imported into the
first task row of the Milestones schedule. In this example (the first row was a title row and not needed in the schedule)
you will see “TASKS”. Right click the word “TASKS” and choose Delete Task.
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More information about the Milestones import map

Fields in the Map and how they translate into the Milestones Schedule
Column Custom Fields
When mapped into the following Milestones fields, information from a spreadsheet will display in a Milestones text column.
Milestones Text columns just display text and do not populate the schedule or calculate values.

Milestones custom fields

Milestones allows 20 columns of information on a single schedule. (10 columns on either side of the schedule area.)
Columns 1-10 are on the left side of the schedule.
Columns 11-20 on the right side of the schedule.
Column numbering goes from left to right, therefore column number 1 is the 10th column away from the left side of the
schedule area. Column 10 is next to the schedule area on the left side. On the right side, column 11 is the column next to
the schedule area and column 20 is the tenth column away from the schedule area. See picture.

Milestones column layout
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Task start and end date custom fields
When mapped into the following Milestones fields, date information from a spreadsheet will display symbols connected
with a bar or just a symbol in a Milestones schedule.

Milestones Custom Fields

When dates from columns in a spreadsheet are mapped into a combination
of Task_#_Start Date and Task_#_End
Date fields (the # must be the same) ,
a start symbol, a bar and an end symbol are added to the schedule. See
picture.

Date information in a spreadsheet
must be formatted as month/day/
year.

Date information generates two symbols with a bar

When a date column from a spreadsheet is mapped to either the
Task_#_Start Date or the
Task_#_End field a single milestone
will be added to the schedule. See
picture.
Date information in a spreadsheet
must be formatted as month/day/
year.

Date information generates a symbol

When Milestones Professional imports from Excel it uses the symbols in the toolbox in a specific order.
This order is left to right, top to bottom. If you skip a date field in the mapping, Milestones skips a symbol in the toolbox.
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Task Milestone Date Custom Fields
When mapped into the following Milestones Custom Fields, date information from a spreadsheet will display individual
symbols in a Milestones schedule.
Milestone_Date_1
Milestone_Date_2
Milestone_Date_3
Milestone_Date_4
Milestones Custom
Fields

Date information in a spreadsheet
must be formatted as month/day/
year.

Date information generates a symbol (milestone)

Task Date and Time Custom Fields
When mapped into the following Milestones Custom Fields, date and time information from a spreadsheet will display symbols connected with a bar or just a symbol in a Milestones schedule. These symbols will be placed on the schedule at the
date and time as specified in the spreadsheet columns.

Milestones custom fields

When date and time information from
columns in a spreadsheet are mapped
to a combination of Task_#_Start,
Year, Month, Day Hour, Minute and
Task_#_End, Year, Month, Day, Hour,
Minute (the # must be the same) a
start symbol, a bar and an end symbol
are added to the schedule. See picture.

If only mapped to either the
Task_#_Start, Year, Month, Day Hour,
Minute or the Task_#_End, Year,
Month, Day, Hour, Minute fields a
single milestone will be added to the
schedule. See picture.
Detailed date information generates a symbol, bar, symbol or just a symbol
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Outline Level WBS Custom Field
When mapped into the following Milestones Custom Fields, Outline Level and WBS information from a spreadsheet will
display outline levels & WBS levels in the Milestones schedule.
Outline_Level
WBS_Number
Milestones
Custom Fields

Outline Level example:
Map the outline level field from a spreadsheet to the Outline Level field in Milestones.






Notice the Project column information
in the Milestones schedule is indented
based on the outline level. This indentation was set up in the Milestones
schedule before importing. Using the
arrow tool click on the column heading. The toolbar changes to the Selection tab with Current Object: Column
Heading. Choose Switch to Column.
Type in a value under Indent per Outline Level. Press the apply
button. (Every column needs an indention value if you want the column to be
indented based on the outline level.)
You can map the Outline Level to a column or you can set up an Outline Level
SmartColumn in Milestones before imOutline Level Results
porting and have Milestones populate
the column. The Lev. Column (an outline level SmartColumn) in the Milestones schedule was set up in Milestones prior
to importing.
To have summary bars generate in a Milestones schedule choose the Layout tab. In the Other section choose Summary
Bar Settings. Under When to Draw choose Always.

WBS Example:
WBS numbering works the same as the outlining import. Map the WBS field from the spreadsheet to the WBS field in Milestones. The column to be indented based on WBS must be set up with indention in the Milestones file before importing.
You can map the WBS numbering to a column or you can set up a WBS SmartColumn in Milestones before importing and
have Milestones populate the column. In Milestones you have the option to select your WBS formatting.

WBS Options

WBS Results
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Successors Custom Field
When mapped into the following Milestones field, Successor information from a spreadsheet will display vertical links between tasks in the Milestones' schedule.
Successors
Milestones Custom Field

How to format successor information in the
spreadsheet.
1. Click on the cell with in the successor column
where the link is to start.
2. Next enter the task row number to where the
link is going. Note: The first task row in spreadsheet is counted as 0.
3. Finally, enter the direction of the link. Choose
from one of the following options: SF (Start to
Finish) SS (Start to Start) FS (Finish to Start) FF
(Finish to Finish).
Successors Results

Percent Complete Custom Field
When mapped into the following Milestones field, Percent Complete information from a spreadsheet will display the percent complete of a task by establishing a status symbol then filling the symbols and bars for a task with color.
Percent_Complete
Milestones Custom Field

 To have percent complete be accurate, hourly
minute detail must be turned on in Milestones.
Choose the Dates tab. In the Start and End
Dates section, choose More Settings. Click
Hourly /Minute.  both Allow Hourly and Minute detail.
 To have the task bars fill with color based on the
percent complete, you must have fill to status
turned on. Choose the Dates tab. In the Date
Related Settings section  both Symbols &
Bars: Fill to Status Date
 The 32nd symbol in the toolbox becomes the
status symbol. Double click this symbol in the
toolbox to change its properties.

Percent Complete Results

Duration Custom Field
When mapped into the following Milestones fields, Duration information from a spreadsheet will display a symbol, bar,
symbol in the Milestones schedule.
Duration and Negative_Duration
 A positive duration value in the spreadsheet is used to generate a symbol, bar, symbol when the task’s start date is available in
the spread sheet and imported.
 A negative duration value in the spreadsheet
is used to generate a symbol, bar, symbol
when the task’s end date is available in the
spread sheet and imported.
 The Negative_Duration import field in the
Milestones custom import is used only when a
negative number can not be used.
Duration Results
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